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Description
This reference design uses Texas Instruments’ nanopower operational amplifiers, comparators, system
timers, temperature sensors, and the multi-standard
2.4-GHz wireless microcontroller (MCU) platform to
demonstrate an ultra-low-power carbon monoxide
detector with extremely long battery life and no wiring
required.
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Applications
• Fire Safety Systems: Gas Detection
• HVAC Systems: Air Quality and Gas Detection
• Battery Powered Systems
• Building Automation
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Features
• Use of Nano-Power Analog Ultra-Low-Power
Design Resulting in 10-Year Battery Life From
Single CR2032 Coin Cell
• Carbon Monoxide Gas Sensor and Analog Logic
Always Powered On To Enable Continuous
Monitoring and Fast Response Times
• Bluetooth® Low Energy (BLE) Wireless
Connectivity Reduces Installation Costs and Allows
Multiple Sensors to Communicate With Single Host
• Self-Check and End-of-Life Monitoring Recognizes
Malfunctioning Gas Sensor and Reports Status
Every Five Minutes (Configurable)
• Carbon Monoxide Gas Detection Range of 0 to
1000 ppm With ±15% Accuracy

See Table 2 for other available options
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System Description
Carbon monoxide (CO) is a colorless, odorless, tasteless, poisonous gas produced by the incomplete
burning of fuels such as coal, kerosene, natural gas, and propane. Combustion engines such as those
found in cars and lawn mowers can also produce CO. Many industrial and building automation systems
rely on CO sensors to warn users when CO concentrations reach unsafe levels. Increasingly, these
systems use wireless sensor nodes to reduce the installation costs and the make the systems more
flexible for future expansion by eliminating wiring. However, one of the major limitations for a large
wireless network is power. Also, because these systems are battery powered, the maintenance cost
associated with periodic battery replacement can become prohibitive.
Enabled by Texas Instruments' nano-power amplifiers, comparators, system timers, temperature sensors,
and the SimpleLink™ ultra-low-power wireless MCU platform, this reference design demonstrates a
wireless CO sensor node requiring no wiring while also fully maximizing the battery life.
At a high level, this reference design consists of a CR2032 coin cell battery, one nano-power op amp, one
nano-power comparator, an ultra-low-power wireless MCU, a nano-power system timer, a temperature
sensor, and an electrochemical CO sensor. The op amp forms a transimpedance amplifier to gain and
filter the electrochemical CO sensor current. The comparator generates an interrupt to the wireless MCU
when the voltage output of the transimpedance amplifier reaches a level corresponding to an unsafe CO
concentration. In this manner, the MCU can operate in its lowest power shutdown mode during times
when the CO level is within acceptable limits and only wakes up to monitor the CO level when it reaches
unsafe limits. The nano-power system timer generates a periodic interrupt to the wireless MCU such that
the MCU can carry out a check of the sensor and send a beacon to the host indicating the status of the
system. The temperature sensor is used to adjust the CO concentration calculation in cases where the
sensor output varies with temperature. Due to the nano-amp operation of the analog signal chain
components and the ultra-low power consumption of the wireless MCU, this reference design achieves a
10-year battery life from a single CR2032 coin cell battery.
This design guide addresses component selection, design theory, and the testing results of this design
system. The scope of this design guide gives system designers a head-start in integrating TI’s nano-power
analog components, and the SimpleLink ultra-low-power wireless MCU platform.
The following subsections describe the various blocks within the reference design system and what
characteristics are most critical to best implement the corresponding function.

1.1

Key System Specifications
Table 1. Key System Specifications
PARAMETER

2

SPECIFICATION

DETAILS

Gas sensor

Figaro TGS5342 (electrochemical type)

Section 2.2.5

Bluetooth antenna

Inverted F PCB antenna

Section 2.4.4

Input power source

CR2032 lithium-ion coin cell battery (3.0 V nominal voltage)

Section 2.2.7

Beacon frequency

Firmware will broadcast BLE beacon once every 5 minutes by default

Section 2.4.5

Visual indicator

Two LEDs used to indicate sensor malfunction and high gas
concentration

Section 2.4.5

Calibration

Gas sensor sensitivity and transimpedance amplifier gain
programmable through UART interface

Average standby-state current
consumption

1.07 μA

Estimated battery life

> 10 years

Section 2.4.5 and
Section 3.1.4
Section 3.2.1.1 and
Section 3.2.2.1
Section 3.2.2.1

Radio transmission range

> 54 meters

Section 3.2.1.4 and
Section 3.2.2.4

Operating conditions

50ºC ambient temperature with 40% ± 10% relative humidity
0ºC ambient temperature with 30% ± 5% relative humidity

Section 3.2.1.3 and
Section 3.2.2.3

Gas detection range

0 to 1000 ppm

Section 3.2.1.3 and
Section 3.2.2.2

Form factor

1.7 × 4.1 in (43.18 × 104.14 mm)
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Block Diagram
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Figure 1. Wireless CO Sensor System Block Diagram

2.2
2.2.1

Design Considerations
Operational Amplifier
The electrochemical gas sensor outputs a current in the nano-amp range, which must be converted to a
voltage and amplified using a transimpedance amplifier. A filtering function is also necessary to limit the
noise bandwidth of the system before reaching the input to the comparator and microcontroller’s analogto-digital converter (ADC). The filtering function also limits the response of the system to fast changes in
gas concentration.
For an extremely long battery life, this reference design uses the LPV811 because of its low current
consumption of 425 nA (typical). Other considerations that make the LPV811 ideal for this reference
design are its low input voltage offset and low input bias current, which allow use of high-value resistors,
and rail-to-rail operation on both input and output. Additionally, the LPV811 integrates EMI protection to
reduce sensitivity to unwanted RF signals, which is useful for low-power designs because of their highimpedance nodes.

2.2.2

Comparator
To maximize power savings, this reference design keeps the MCU in its lowest power shutdown mode the
majority of the time and only wakes the MCU when the CO level reaches unsafe levels. To accomplish
this, a comparator circuit is used to convert the amplified and filtered version of the sensor output into a
digital signal, which can be used as a wakeup interrupt to the MCU.
The low current consumption of only 75 nA (typical) makes the TLV3691 in this reference design ideal.
Other considerations for the comparator in this reference design include its low input voltage offset and
low input bias current. Additionally, the TLV3691 features a rail-to-rail input stage with an input common
mode range, which exceeds the supply rails by 100 mV, thereby preventing output phase inversion when
the voltage at the input pins exceed the supply. This translates not only into robustness to supply noise,
but also maximizes the flexibility in adjusting the comparator threshold in this design.
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Ultra-Low-Power Wireless MCU
In this reference design, transmitting the sensor information to some central location for processing is
necessary. However, because power consumption is always a concern in battery-based applications, the
radio and processor must be low power. Also, the wireless protocol required for the end-equipment
system is an important consideration for the selection of the radio device.
With TI’s SimpleLink ultra-low-power wireless MCU platform, low power with a combined radio and MCU
enables an extremely long battery life for sensor end-nodes. Furthermore, the CC2650 is a multi-standard
device with software stack support for ZigBee®, 6LoWPAN, and ZigBee RF4CE. In this reference design,
the hardware is built to work with other protocols as well.

2.2.4

Nano-Power System Timer
This reference design is able to achieve extremely long battery life by means of a nano-power system
timer. The use of this type of device replaces the internal timer of any standard microcontroller with a
discrete analog system timer that consumes much less power than the microcontroller’s internal timer. A
nano-power system timer can be used either to bring an MCU out of sleep mode by means of a pin
interrupt, or to completely shut off power to the system, in whole, or in part.
In this reference design, the TPL5111 device was chosen to generate a wakeup interrupt to the MCU,
which allows the MCU to stay in it shutdown mode the majority of the time, reducing the MCU’s off-state
current drawn from the battery to the hundreds of nano-amps. The timer interval is user-selectable by
means of a resistor and can range from 100 ms up to two hours, with a typical time base accuracy of 1%.
The TPL5111 device regularly brings the MCU out of shutdown mode such that it can carry out a set of
tasks including sensor check and transmission of a beacon to the host.

2.2.5

CO Sensor
The sensor chosen for this reference design is the Figaro TGS5342 two-terminal electrochemical carbon
monoxide sensor. This sensor was chosen due to the availability of characterization data across multiple
CO levels as well as sensor performance data in different environmental conditions. The sensor also
supports a 10-year lifetime, which is required for this reference design.
While the test results collected for this reference design are focused on a particular sensor part number, it
is expected that similar results can be obtained with any similarly specified two-terminal electrochemical
sensor.

2.2.6

Temperature Sensor
The current output of electrochemical CO sensors can vary with temperature. For example, at a
concentration of 400 parts per million, the current output of the TGS5342 CO sensor can be 20% higher at
60°C and almost 40% lower at 0°C compared to the current output at 20°C.
In this reference design, firmware in the MCU adjusts gas concentration calculations using an internal
temperature correction table and the temperature reading from the TMP103. The TMP103 is capable of
reading temperatures to a resolution of 1°C. The temperature correction table was derived using
information in the sensor datasheet. To save power and extend battery life, the TMP103 sensor supply
voltage is only supplied when a temperature reading is needed.

2.2.7

Coin Cell Battery
The power source for this reference design is a CR2032 lithium-ion coin cell. The selection of the CR2032
coin cell battery as the power source was due to the ubiquity of that battery type, particularly in small form
factor systems such as a sensor end-node.
The voltage characteristics of a lithium-ion CR2032 coin cell battery are also ideal. The output voltage
remains relatively flat throughout the discharge life until the cell is nearly depleted. When the cell is
depleted, the output voltage drops off relatively quickly.
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The temperature characteristics of lithium-ion batteries are also superior to that of alkaline cells,
particularly at lower temperatures. This superiority is due to lithium-ion cells having a non-aqueous
electrolyte that performs better than aqueous electrolytes commonly found in alkaline batteries. However,
the CR2032 coin cell battery and the gas sensor (see Section 2.2.5) are the limiting components in terms
of the operating temperature range; all of the integrated circuits and other electrical components are
specified to operate at a wider temperature range than the battery and gas sensor. Therefore, the
specified operating temperature range of the TI Design system is 0°C to 50°C. Given an appropriate
weather-proof enclosure, this reference design system is suited for both indoor and outdoor use.
Immediately following the battery is a low RDS_ON P-channel MOSFET and a bulk capacitor. The
P-channel MOSFET prevents damage to the hardware if the coin cell battery is inserted backwards while
minimizing the forward voltage drop in normal operation. The bulk capacitor is sized to prevent too much
voltage droop, particularly during the transitions into the MCU on-state for radio transmissions.

2.3

Highlighted Products
The Low-Power Carbon Monoxide (CO) Detector With BLE and 10-Year Coin Cell Battery Life Reference
Design features the following devices:
• LPV811 (Section 2.3.1): Nano-power, CMOS input, rail-to-rail I/O operation amplifier
• TLV3691 (Section 2.3.2): Nano-power, CMOS input, rail-to-rail input comparator
• CC2650 (Section 2.3.3): SimpleLink multi-standard 2.4-GHz ultra-low-power wireless MCU
• TPL5111 (Section 2.3.4): Ultra-low-power timer with MOS driver and MOSFET power ON
• TMP103 (Section 2.3.5): Low-power, digital temperature sensor with two-wire interface
For more information on each of these devices, see their respective product folders at TI.com.
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LPV811
The LPV811 is an ultra-low-power precision operational amplifier family for “Always ON” sensing
applications in battery powered wireless and low power wired equipment. With 8 kHz of bandwidth from
425 nA of quiescent current and a trimmed offset voltage to under 370 µV, the LPV811 amplifiers provide
the required precision while minimizing power consumption in equipment such as gas detectors and
portable electronic devices where operational battery-life is critical.
In addition to being ultra-low-power, the LPV811 amplifier has CMOS input stages with fempto-amp bias
currents which reduces errors commonly introduced in transimpedance amplifier (TIA) configurations with
megaohm feedback resistors and high source impedance source applications. The LPV811 amplifiers also
feature a negative-rail sensing input stage and a rail-to-rail output stage that swings within millivolts of the
rails, maintaining the widest dynamic range possible. Likewise, EMI protection is designed into the
LPV811 in order to reduce system sensitivity to unwanted RF signals from mobile phones, Wi-Fi®, radio
transmitters, and tag readers.
The LPV811 amplifier operate with a single supply voltage as low as 1.6 V, ensuring continuous
performance in low battery situations over the extended temperature range of –40ºC to 125ºC. The single
and dual channel versions are available in industry standard 5-pin SOT-23 package.
Features:
• Nano-power supply current: 425 nA/channel
• Offset voltage: 370 µV (max)
• TcVos: 1 µV/°C
• Gain bandwidth: 8 kHz
• Unity-gain stable
• Low input bias current: 100 fA
• Wide supply range: 1.6 to 5.5 V
• Rail-to-rail output
• No output reversals
• EMI protection
• Temperature range: –40°C to +125°C
• Industry standard 5-pin SOT-23 packages
Table 2. Precision Nano-Power Amplifier Family

6

FAMILY

CHANNEL
COUNT

LPV821

1

700 nA

20 µV

1.7 to 3.6 V

LPV811

1

450 nA

370 µV

1.6 to 5.5 V

LPV812

2

425 nA

300 µV

1.6 to 5.5 V

OPA369

1,2

800 nA

750 µV

1.8 to 5.5 V

IQ PER CHANNEL
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2.3.2

TLV3691
The TLV3691 offers a wide supply range, low quiescent current of 150 nA (maximum), and rail-to-rail
inputs. All of these features come in industry-standard and extremely small packages, making this device
an excellent choice for low-voltage and low-power applications for portable electronics and industrial
systems.
Available as a single channel, the low-power, wide supply, and temperature range makes this device
flexible enough to handle almost any application from consumer to industrial. The TLV3691 is available in
SC70-5 and 1-mm×1-mm DFN-6 packages. This device is specified for operation across the expanded
industrial temperature range of –40°C to +125°C.
Features:
• Low quiescent current: 75 nA
• Wide supply:
– 0.9 to 6.5 V
– ±0.45 to ±3.25 V
• MicroPackages: DFN-6 (1 mm × 1 mm), 5-pin SC70
• Input common-mode range extends 100 mV beyond both rails
• Response time: 24 µs
• Low input offset voltage: ±3 mV
• Push-pull output
• Industrial temperature range: –40°C to +125°C

2.3.3

CC2650
The CC2650 is a wireless MCU targeting Bluetooth, ZigBee and 6LoWPAN, and ZigBee RF4CE remote
control applications.
The device is a member of the CC26xx family of cost-effective, ultra-low-power, 2.4-GHz RF devices. Very
low active RF and MCU current and low-power mode current consumption provide excellent battery
lifetime and allow for operation on small coin cell batteries and in energy-harvesting applications.
The CC2650 device contains a 32-bit Arm® Cortex®-M3 processor that runs at 48 MHz as the main
processor and a rich peripheral feature set that includes a unique ultra-low-power sensor controller. This
sensor controller is ideal for interfacing external sensors and for collecting analog and digital data
autonomously while the rest of the system is in sleep mode. Thus, the CC2650 is ideal for applications
within a whole range of products including industrial, consumer electronics, and medical.
The Bluetooth low energy controller and the IEEE 802.15.4 MAC are embedded into ROM and are partly
running on a separate Arm Cortex-M0 processor. This architecture improves overall system performance
and power consumption and frees up flash memory for the application.
The Bluetooth and ZigBee stacks are available free of charge from TI.com.
Features:
• Microcontroller:
– Powerful Arm Cortex-M3
– EEMBC CoreMark® score: 142
– Up to 48-MHz clock speed
– 128KB of in-system programmable flash
– 8KB of SRAM for cache
– 20KB of ultra-low-leakage SRAM
– 2-pin cJTAG and JTAG debugging
– Supports over-the-air (OTA) upgrade
• Ultra-low-power sensor controller:
– Can run autonomous from the rest of the system
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– 16-bit architecture
– 2KB of ultra-low-leakage SRAM for code and data
Efficient code size architecture, placing drivers, Bluetooth low energy controller, IEEE 802.15.4 MAC,
and Bootloader in ROM
RoHS-compliant packages:
– 4-mm × 4-mm RSM VQFN32 (10 GPIOs)
– 5-mm × 5-mm RHB VQFN32 (15 GPIOs)
– 7-mm × 7-mm RGZ VQFN48 (31 GPIOs)
Peripherals:
– All digital peripheral pins can be routed to any GPIO
– Four general-purpose timer modules (eight 16-bit or four 32-bit timers, PWM each)
– 12-bit ADC, 200-ksamples/s, 8-channel analog MUX
– Continuous time comparator
– Ultra-low-power analog comparator
– Programmable current source
– UART
– 2× SSI (SPI, Microwire, TI)
– I2C
– I2S
– Real-time clock (RTC)
– AES-128 security module
– True random number generator (TRNG)
– 10, 15, or 31 GPIOs, depending on package option
– Support for eight capacitive-sensing buttons
– Integrated temperature sensor
External system:
– On-chip internal DC/DC converter
– Very few external components
– Seamless integration with the SimpleLink CC2590 and CC2592 range extenders
– Pin compatible with the SimpleLink CC13xx in 4-mm × 4-mm and 5-mm × 5-mm VQFN packages
Low power:
– Wide supply voltage range:
• Normal operation: 1.8 to 3.8 V
• External regulator mode: 1.7 to 1.95 V
– Active-mode RX: 5.9 mA
– Active-mode TX at 0 dBm: 6.1 mA
– Active-mode TX at 5 dBm: 9.1 mA
– Active-mode MCU: 61 µA/MHz
– Active-mode MCU: 48.5 CoreMark/mA
– Active-mode sensor controller: 8.2 µA/MHz
– Standby: 1 µA (RTC running and RAM/CPU retention)
– Shutdown: 100 nA (wake up on external events)
RF section:
– 2.4-GHz RF transceiver compatible with Bluetooth low energy 4.2 specification and IEEE 802.15.4
PHY and MAC
– Excellent receiver sensitivity (–97 dBm for BLE and –100 dBm for 802.15.4), selectivity, and
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blocking performance
Link budget of 102 dB or 105 dB (BLE/802.15.4)
Programmable output power up to 5 dBm
Single-ended or differential RF interface
Suitable for systems targeting compliance with worldwide radio frequency regulations:
• ETSI EN 300 328 (Europe)
• EN 300 440 Class 2 (Europe)
• FCC CFR47 Part 15 (US)
• ARIB STD-T66 (Japan)
Tools and development environment:
– Full-feature and low-cost development kits
– Multiple reference designs for different RF configurations
– Packet sniffer PC software
– Sensor controller studio
– SmartRF™ Studio
– SmartRF Flash Programmer 2
– IAR Embedded Workbench® for Arm
– Code Composer Studio™ (CCS)
–
–
–
–

•

2.3.4

TPL5111
The TPL5111 nano-timer is a low power system timer, ideal for power gating in duty cycled or battery
powered applications. Consuming only 35 nA, the TPL5111 can be used to enable and disable the power
supply for a microcontroller or other system device, drastically reducing the overall system stand-by
current during the sleep time. This power saving enables the use of significantly smaller batteries and
makes the TPL5111 well suited for energy harvesting or wireless sensor applications. The TPL5111
provides selectable timing intervals from 100 ms to 7200 s. In addition, the TPL5111 has a unique oneshot feature where the timer will only assert its enable pulse for one cycle. The TPL5111 is available in a
6-pin SOT23 package.
Features:
• Selectable time intervals: 100 ms to 7200 s
• Timer accuracy: 1% (typical)
• Current consumption at 2.5 V: 35 nA (typical)
• Resistor selectable time interval
• Manual power-on input
• One-shot feature
• Supply voltage range: 1.8 to 5.5 V
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TMP103
The TMP103 is a digital output temperature sensor in a four-ball wafer chip-scale package (WCSP). The
TMP103 is capable of reading temperatures to a resolution of 1°C.
The TMP103 features a two-wire interface that is compatible with both I2C and SMBus interfaces. In
addition, the interface supports multiple device access (MDA) commands that allow the master to
communicate with multiple devices on the bus simultaneously, eliminating the need to send individual
commands to each TMP103 on the bus.
Up to eight TMP103s can be tied together in parallel and easily read by the host. The TMP103 is
especially suitable for space-constrained, power-sensitive applications with multiple temperature
measurement zones that must be monitored.
The TMP103 is specified for operation over a temperature range of –40°C to +125°C.
Features:
• Multiple device access (MDA):
– Global read/write operations
• I2C and SMBus-compatible interface
• Resolution: 8 bits
• Accuracy: ±1°C typical (–10°C to +100°C)
• Low quiescent current:
– 3-μA active IQ at 0.25 Hz
– 1-μA shutdown
• Supply range: 1.4 to 3.6 V
• Digital output
• 4-ball WCSP (DSBGA) package

10

Low-Power Carbon Monoxide Detector With BLE and 10-Year Coin Cell
Battery Life Reference Design

TIDUBX8C – July 2016 – Revised November 2017
Submit Documentation Feedback

Copyright © 2016–2017, Texas Instruments Incorporated

System Overview

www.ti.com

2.4

System Design Theory
The Low-Power Carbon Monoxide (CO) Detector With BLE and 10-Year Coin Cell Battery Life Reference
Design measures carbon monoxide concentration by monitoring the current output of an electrochemical
carbon monoxide sensor. Because the sensor outputs a very small current, it must be converted to a
voltage, amplified to a reasonable signal level, and at the same time filtered to remove noise and minimize
false trigger events. The amplified analog output is converted to a digital signal by a comparator function
whose output can be used as an interrupt to the wireless MCU to save power by only waking up the MCU
when it is needed. The analog output can also be directly sampled by the wireless MCU’s internal ADC.
Software can convert the sampled value into an equivalent carbon monoxide concentration through a
simple formula. The following sections discuss the details of the design for the different circuit sections
that make up the design’s overall subsystem.

2.4.1

Gas Sensor Basic Theory
The following sections provide some background information on CO sensors and the analog circuitry
required to operate them.

2.4.1.1

Basic Transimpedance Amplifier Circuit

An electrochemical gas sensor generates a current linearly proportional to a gas concentration through a
series of chemical reactions. The gas sensing layer of a two-terminal electrochemical sensor consists of a
working electrode and a counter electrode separated by an alkaline electrolyte mixture. In the case of a
CO sensor, as CO gas reaches the sensing layer, electrons are generated from the reaction of CO and
anions in the electrolyte. As shown in Figure 2, current flows between working and counter electrodes
when an electrical path is created between them. Because there is a linear relationship between the
current and the gas concentration, the sensor can be calibrated using a known gas concentration, and
other gas concentrations can be derived from the output of the sensor.
Gas
Working electrode

eí

Alkaline electrolyte

A

Counter electrode
Air
Copyright © 2016, Texas Instruments Incorporated

Figure 2. Electrochemical Gas Sensor Operating Principle
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The basic transimpedance circuit for amplifying and filtering the output current of a gas sensor is shown in
Figure 3. When the gas sensor is exposed to CO gas, current flows from the working electrode to the
counter electrode. The transimpedance amplifier converts the current of the sensor to a voltage with a
gain set by the feedback resistor RF. The combination of RF and CF set the upper limit on a low-pass
filter. The resistor RL is sometimes recommended by CO sensor manufacturers to add stability to the
circuit when resistance is too low. The recommended value for RL is taken from the CO sensor datasheet.
CF

RF
I
VCC
RL
WE

í
+

CO
sensor

VOUT
CE
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Figure 3. Basic Transimpedance Circuit for Gas Sensor
The output current of electrochemical sensors can vary with ambient temperature. Applications which
require higher accuracy readings under a wide range of operating temperatures can adjust the sensor
reading using a temperature correction table in software. The sensor’s susceptibility to temperature can be
derived from the sensor’s datasheet.

12

Low-Power Carbon Monoxide Detector With BLE and 10-Year Coin Cell
Battery Life Reference Design

TIDUBX8C – July 2016 – Revised November 2017
Submit Documentation Feedback

Copyright © 2016–2017, Texas Instruments Incorporated

System Overview

www.ti.com

2.4.1.2

Sensor Polarization

A sensor can become polarized when it is stored a long time without a connection between the working
and counter electrodes. A polarized sensor can take a minutes or hours to stabilize after it is connected to
the operating circuit.
A short circuit (or a resistance less than 1 kΩ) must be kept between the sensor electrodes when power is
removed from the system to prevent the sensor from becoming polarized. There are several methods to
achieve this. As shown in Figure 4, this reference design uses a p-channel JFET connected across the
sensor with its gate connected to the system voltage, VCC. When system power is removed, the JFET
turns on creating a short between the working and counter electrodes. When system power is applied, the
JFET turns off and the current from the sensor passes to the TIA.
CF

VCC

RF
VCC
RL
í

WE
JFET
P-Channel

CO
sensor

+
VOUT

CE
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Figure 4. Sensor Anti-Polarization Technique Using P-Channel JFET
When selecting the p-channel JFET, the maximum gate-to-source cutoff voltage, VGS(off), must be carefully
considered so that the JFET does not turn on during normal operation. The VGS(off) of the JFET must be
greater than the minimum operating system voltage.
This reference design uses the MMBFJ270 JFET from Fairchild with the gate connected to the battery
voltage to keep the sensor from becoming polarized. The maximum VGS(off) of 2.0 V ensures the JFET
remains off even when the battery starts to lose charge.
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Sensor Self-Check

The functionality of the gas sensor must be continuously monitored such that any failures can be signaled
and reported to the host. This TI Design implements a modified version of the self-check circuit described
by Figaro in the TGS5342 CO sensor technical documentation.
The self-check feature consists of driving a small test current (approximately 1 µA) into the sensor for a
short amount of time (approximately four to five seconds) while the sensor is disconnected from the TIA,
then monitoring the sensor response after the test current is removed. By analyzing the sensor response
to the test current, the MCU can determine when the sensor is operating normally and also several fail
conditions such as a short-circuit, an open-circuit, and a loss of sensitivity.
In this reference design, the self-check feature is controlled by the MCU through one of its I/O pins (see
Figure 9 in Section 2.4.2). To initiate the test, the MCU drives its I/O pin to a logic high. This action causes
the p-channel JFET Q2 to turn off, thereby disconnecting the sensor from the TIA. The I/O pin sources the
test current directly to the sensor through the resistor R5. To stop the test current, the MCU drives its I/O
pin low, at which point the JFET turns on and sensor is once again connected to the TIA.
This reference design uses the MMBFJ270 JFET from Fairchild for the self-check circuit. The MMBFJ270
has a maximum gate-to-source cutoff voltage, VGS(off), of 2.0 V, which can be met by the minimum VOH of
2.68 V of the MCU I/O pins. The value of R5 was chosen to drive approximately 1 µA of current into the
sensor assuming a minimum VOH of 2.68 V.
Figure 5 shows a "normal" sensor response after the test current has been applied for five seconds and
removed. The MCU monitors the output voltage of the TIA in the second after the test current is removed.
The sensor and TIA circuit are deemed operational if the TIA output voltage is greater than 2.3 V.

CH1 = MCU I/O

CH2 = TIA output voltage

Figure 5. Normal Sensor Response to Test Current
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Figure 6 shows the sensor response when the sensor is operating normally. In this case, the sensor is
exposed to a small amount of CO gas, hence the TIA output voltage is greater than 0 V. Note that the
sensor response is like the case shown in Figure 5, except that the TIA output settles down the voltage
corresponding to the CO gas concentration instead of 0 V.

CH1 = MCU I/O

CH2 = TIA output voltage

Figure 6. Normal Sensor Response to Test Current (With CO Gas)
Figure 7 shows the sensor response when the sensor is in an open-circuit condition. In this case, there is
no output from the TIA during or after the test pulse is applied.

CH1 = MCU I/O

CH2 = TIA output voltage

Figure 7. Sensor in Open Circuit
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Figure 8 shows the sensor response when the sensor is in a short-circuit condition. In this case there is a
small voltage at the output of the TIA before and after the test pulse is applied. During the test pulse, the
TIA output voltage goes to either the V+ or the V– rail of the TIA op amp; in this case, the output goes to
the V– rail (GND).
When the sensor becomes shorted, the short will essentially create a non-inverting amplifier with the
RDS_ON of Q2 acting as the gain resistor and RF1 as the feedback resistor. The voltage offset of the TIA op
amp will be amplified and drive the TIA output. Because the voltage offset will vary across different op
amps, the TIA output voltage will also vary.

CH1 = MCU I/O

CH2 = TIA output voltage

Figure 8. Sensor in Short-Circuit
The difference between a "normal" sensor (Figure 5 and Figure 6), an open sensor (Figure 7), and a
shorted sensor (Figure 8) can be used by firmware to identify a working sensor from a non-working
sensor. However, note that the TIA response of an open sensor a shorted sensor can look very similar.
Therefore, it is not possible to distinguish between the short and open sensor conditions.
Note that the sensor will take some time to recover after the test current is applied, with a longer period if
the test current is applied for a longer period of time. CO gas sampling will be unreliable and unavailable
during this period of time. Also, system power will increase during sensor test, reducing battery life. For
these reasons, the period between sensor tests must be maximized as much as possible. The firmware
used in this reference design allows 30 seconds for the sensor to recover after the test current is applied
and the sensor is tested every 5 minutes. See Section 3.2.2.1.1 and Section 3.2.2.1.5 for more information
on system power consumption during sensor testing.
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2.4.2

Analog Signal Path
The analog signal conditioning section is shown in the schematic in Figure 9. The output current from the
gas sensor is passed through a TIA with a low-pass filter. Following the TIA is a comparator designed to
generate an interrupt to the MCU when a certain gas concentration has been reached. The p-channel
JFETs Q1 is used to prevent the sensor from becoming polarized and Q2 is used by the MCU to test the
sensor. Both Q1 and Q2 are discussed further in Section 2.4.1.2 and Section 2.4.1.3.
CF1
0.1 µF
RF1
1.78 0Ÿ
VBATT
VBATT

VBATT
R2
2 0Ÿ
RL1

VOUT

0.1 µF

0.1 µF
RO1
49.9 NŸ

í

WE
0Ÿ

í
+

Q1
J270

CO
sensor

U1
LPV811

MCU
I/O

VBATT
C4
1 µF

+
R4
22 0Ÿ

U3
TLV3691

CE
R6
2 0Ÿ

Q2
J270
MCU
I/O

C8
0.1 µF

R5
2.55 0Ÿ
Copyright © 2016, Texas Instruments Incorporated

Figure 9. CO Sensor Analog Signal Path Schematic

2.4.2.1

TIA Design

There are many circuit topologies available to implement a TIA stage. The choice ultimately depends on
the performance requirements of the overall system. Because of the slow response of the CO sensor to
changes in gas concentration, high bandwidth is not required; this allows the use of a low-bandwidth
operational amplifier with a 0-V bias. Another key aspect for this application is low input offset voltage on
the operational amplifier to prevent voltage shifts due to the internal resistance of the CO sensor.
The TIA stage amplifies the output of the sensor and implements a low-pass filter. The gain of the TIA is
1.78 × 106 V/A was selected to maximize the output signal for the target gas concentration range (0 to
1000 ppm) while staying within the limits of the ADC input voltage limits on the MCU. The chosen cutoff
frequency for the low-pass filter is 0.89 Hz. The cutoff frequency depends on the noise in the system and
required response time to changing gas concentrations. Equation 1 and Equation 2 show the gain and
cutoff frequency for the TIA stage.
V OUT
A TIA =
= RF1 = 1.78 ´ 10 6 V / A
iS
(1)
f high =

1
1
=
= 0.89 Hz
2p ´ RF1´ CF1
2p ´ 1.78 MW ´ 0.1 mF

(2)

In Equation 1, VOUT is the output of U1 and iS is the sensor current.
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With a maximum sensitivity of 1.4 nA/ppm specified by the TGS5342 sensor, the output voltage VOUT of
the TIA will be approximately 2.49 V at a temperature of 20°C. At a temperature of 60°C, the current
output of the TGS5342 sensor increases by a factor of approximately 1.15, hence VOUT will increase to
approximately 2.87 V. The calculation for VOUT at these two temperatures is shown in Equation 3,
Equation 4, and Equation 5.
V OUT = GasCon ´ Sensitivity ´ TempCorr ´ A TIA
(3)

V OUT (20 ° C ) = 1000 ppm ´

1.4 nA
1.78 ´ 10 6 V
´ 1.0 ´
» 2.49 V
ppm
A

(4)

6

V OUT (60 ° C ) = 1000 ppm ´

1.4 nA
1.78 ´ 10 V
´ 1.15 ´
» 2.87 V
ppm
A

(5)

In Equation 3, GasCon is the target gas concentration, Sensitivity is the sensitivity of the gas sensor
(expressed in nA/ppm), TempCorr is the temperature correction factor (a unit-less number taken from the
sensor datasheet), and ATIA is the gain of the transimpedance amplifier (expressed in V/A).
2.4.2.2

Comparator Design

The comparator circuit shown in Figure 9 converts the analog output of the TIA to a digital signal, which is
used as an interrupt to the MCU to tell it when the CO level has reached a specific level. The resistor
divider R4 and R6 sets up the threshold that determines the CO level at which the MCU will be
interrupted.
Capacitor C8 is necessary to stabilize the threshold voltage to prevent chatter at the output of the
comparator. This capacitor does not need to be a large value due to the large resistors being used in the
resistor divider, but it must be low ESR and low leakage with ceramic being preferred.
This reference design uses the TLV3691 comparator due to its ultra-low supply current requirements. The
TLV3691 comparator also has rail-to-rail input capability with an input common-mode range that exceeds
the supply rails by 100 mV. This is not required for this design, but it does allow the ability to maximize the
adjustment range of the comparator threshold.
The comparator output will be high when the CO level is below the threshold. When the CO level reaches
the threshold, the comparator output will go low.
The comparator threshold is set by adjusting the voltage divider created by R4 and R6. In this reference
design, R6 is a potentiometer, which allows for easy modification.
To adjust the comparator threshold, follow these steps. First, identify the gas concentration at which the
comparator should trigger. Second, use Equation 6 to derive the required output voltage, VTHRESH, of the
voltage divider.
V THRESH = V OUT = GasCon ´ Sensitivity ´ TempCorr ´ A TIA
(6)
In Equation 6, GasCon is the target gas concentration, Sensitivity is the sensitivity of the gas sensor
(expressed in nA/ppm), TempCorr is the temperature correction factor (a unit-less number taken from the
sensor datasheet), and ATIA is the gain of the TIA (expressed in V/A). Note that the sensitivity of the
TGS5342 CO sensor is printed directly below the bar code on the sensor. For example, a code of "1011"
must be interpreted as 1.011 nA/ppm.
Lastly, Equation 7 can be used to obtain the value for R6.
V THRESH
R11 = R 9 ´
V BATT - V THRESH

(7)

For example, Equation 8 and Equation 9 calculate the value of R6 for a comparator threshold of 65 ppm.
The calculation uses a temperature correction of 0.85, which corresponds to the lowest operating
temperature of 0°C.
V THRESH (0 ° C ) = V OUT (0 ° C ) = 65 ppm ´

1.011 nA
1.78 ´ 10 6 V
´ 0.85 ´
» 99.4 mV
ppm
A

99.4 mV
R11 = 22 MW ´
» 754 kW
3.0 V - 99.4 mV
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Note that at higher temperatures, the comparator will trigger at CO concentrations lower than 65 ppm.
However, the MCU firmware will calculate the true CO concentration by adjusting for temperature. Also, a
sensor with lower sensitivity will generate a lower VOUT at 65 ppm. For this reason, in this reference design
R6 is a variable resistor, which can be adjusted on a per board basis to account for the variations in
sensor sensitivity values.
2.4.3

Power Supply Design
Because of the increasing battery impedance over the life of the battery supply and the low power supply
rejection of the CO sensor, it is important to design the power supply network to prevent current spikes
generated by the MCU from causing false triggers through the analog signal path. While the algorithm
implemented in firmware helps to filter such problems, this unwanted power supply feedback loop can
become an issue. Ideally, the sensor supply would be regulated to break this loop; however, in this design
the extra quiescent current of a regulator would reduce battery life, so other methods were explored.
Figure 10 shows a simplified schematic of the power supply network. The PMOS transistor is used in
place of the traditional Schottky diode for reversed battery protection. Because the peak currents are in
the 10-mA range when the radio transmits, using a low RDS_ON PMOS provides a much lower voltage drop
compared to a Schottky diode, which helps to maximize battery life by allowing the battery to decay to a
lower voltage before the circuit is no longer able to function (for more on this technique, see the
application report Reverse Current/Battery Protection Circuits).
VBATT

Rint

C14
100 µF
+

CR2032
í

Copyright © 2016, Texas Instruments Incorporated

Figure 10. CO Sensor Simplified Power Supply Network Schematic
Capacitor C14 supplies the circuit during periods of high and fast peak current demand, which helps to
maximize the battery capacity and minimize voltage droop on the power supply rail, especially as the
battery approaches its end of life and its internal impedance increases (represented by Rint in Figure 10).
The calculation for C14 is provided in Equation 10. For more details on this calculation and the effects of
high current peaks on battery life and capacity, see the white paper Coin cells and peak current draw.
DQ
C14 =
V MAX - V MIN
(10)
where:
•
•

DQ = Q dis -

Q dis =

V MIN
Rint

t tot

åi n ´ t n

VMAX is the voltage across the capacitor at the start of the current pulse at the end of the battery’s life, and
VMIN is the circuit operating minimum. VMAX is taken to be 2.698 V assuming an unloaded end of life battery
voltage of 2.7 V (VP).
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Based on the power consumption characterization presented in Section 3.2.2.1, the reference design
experiences a period of high-current consumption at the start of the test state and during a packet
transmit. The load profiles based on these two events are shown in Figure 11 and Figure 12.

Figure 11. Power Profile During Startup Period

Figure 12. Power Profile During Packet Transmit Period

Based on these two profiles, two different values for capacitor C14 can be calculated using Equation 10:
2.0 V
7.0 mA ´ 5 ms + 2 mA ´ 46.2 ms ´ 51.2 ms
1 kW
C14 (Startup ) =
= 35.8 mC
2.698 V - 2.0 V
(11)
2.0 V
10.0 mA ´ 4 ms ´ 4.0 ms
1 kW
C14 (Packet ) =
= 45.8 mC
2.698 V - 2.0 V
(12)
This design uses C14 = 100 μF and additional decades of capacitors in parallel for improved impedance
at higher frequencies. The time required to recharge the composite C14 capacitor after the high current
event is given in Equation 13.
æ V P - V MIN
T = Rint ´ C14 comp ´ ln ç
ç V P - V MAX
è

ö
æ 2.7 V - 2.0 V ö
÷ = 1 kW ´ 111.11 μF ´ ln ç
÷ » 0.65 s
÷
è 2.7 V - 2.698 V ø
ø

(13)

The events shown in Figure 11 and Figure 12 are separated by at least 5 seconds (the time during which
the test pulse is driven into the CO sensor). Equation 13 shows that the capacitor will be sufficiently
recharged to support the second pulse of high-current.
2.4.4

Wireless Network Design
The CC2650 wireless MCU does not retain its state or have any control over when it wakes up once it
enters its shutdown mode. For this reason, this reference design is intended to be used in a star network
configuration. This means that each sensor end-node connects directly to a central receiver, which
receives the data from each end-node, and then performs any necessary processing and, if needed,
connection to the cloud. This TI Design is not intended to be used in smart mesh networks.
The firmware for this TI Design sends out non-connectable advertisement packets that contain several
bytes of data containing, CO concentration, battery voltage, temperature, and status flags, among other
things. The firmware can be configured to send additional information for debug purposes. For more
information, see Section 2.4.5.
The antenna on this reference design is the inverted F PCB antenna for 2.4-GHz transceivers and
transmitters. For more details about layout and performance, see the application report 2.4-GHz Inverted
F Antenna.
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2.4.5

Firmware Control
Figure 13 describes the firmware operation in this reference design. The firmware first starts by checking
the status of the user button S1. If the user button is depressed, the firmware enters its calibration
procedure. If the user button is not depressed, the firmware enters its standby state. The CC2650 will be
in shutdown mode while the firmware is in the standby state to conserve power.
The firmware will stay in the standby state until a wake-up interrupt is received from either the comparator
or the system nano-power system timer. If the wake-up source was the system timer, the firmware will
start its sensor test. If the wake-up source was the comparator, the firmware will enter its pre-alarm state.
In the pre-alarm state, the firmware will monitor the CO level every second, using a 10-second moving
average to stabilize the CO sensor output. The CO level is calculated using Equation 14, where GasCon
is the target gas concentration, VOUT is the output voltage of the TIA circuit, Sensitivity is the sensitivity of
the gas sensor (expressed in nA/ppm), TempCorr is the temperature correction factor (unit-less), and ATIA
is the gain of the TIA circuit (expressed in V/A). The values for Sensitivity and ATIA are stored in the MCU
flash during system calibration and the TempCorr values are stored as a table in the firmware source
code.
V OUT ´ TempCorr
GasCon =
Sensitivity ´ A TIA
(14)
The firmware moves into its alarm state if the CO concentration stays above a concentration of 65 ppm for
the minimum response time as indicated in Table 3. The firmware monitors the CO concentration every
second and stays in the alarm state until the CO concentration drops below 65 ppm. A packet is sent to
the host every minute to indicate the alarm state has been reached. A system LED is also toggled to give
a visual indication of the alarm condition.
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Reset button pressed or
power on

START

A

Start calibration
procedure

Yes

Pre-alarm state: Processor monitors CO level
every second (uses 10s moving average) and
starts counter

User button
depressed?

No

Above 65 ppm, minimum
response time not met

Read flash:
Sensitivity and gain
= 0xFFFF?

Yes
Go to trouble state

CO level and
counter status?

Below 65 ppm

Above 65 ppm, minimum
response time met

No

Alarm state: Turn on LED for one second every
four seconds and monitor CO level; send status
packet to host every minute

Standby state: Processor in shutdown until
wakeup interrupt is received

Above 65 ppm

Below 65 ppm

Start system test and
send beacon

Wakeup interrupt
source?

CO level status?

Nano-timer
interrupt OR
user button
Comparator
interrupt

A

Figure 13. Normal Operation Flowchart
Table 3. Carbon Monoxide Concentration and
Response Times
CONCENTRATION
(ppm)

RESPONSE TIME (MINUTES)
MIN

MAX

70 ± 5

60

240

150 ± 5

10

50

400 ± 5

4

15

As previously mentioned, the firmware tests the sensor and TIA circuit periodically and enter a trouble
state if an error condition is detected (see Figure 14). The firmware tests the sensor and TIA circuit
through the use of the self-check circuit described in Section 2.4.1.3. If no error is detected, the firmware
allows 30 seconds for the sensor to stabilize, send a packet to the host with the status flags set to "OK",
and return to the standby state. If an error is detected, the firmware transitions to the trouble state where it
remains until the system is reset. In the trouble state, the firmware continuously toggles LED D2 and
sends a packet to the host with the status flag set to "TROUBLE" every minute.
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START

No

Enable test current for
5 seconds

Wait 30 seconds for
sensor to stabilize
Check CO level

Read ADC output

Yes

Send OK status packet
to host

CO level > 65 ppm?

Yes

ADC output > 2.3 V?

No

Go to pre-alarm state

Return to standby state

Trouble state: Turn on LED for one second
every four seconds; send trouble status packet
to host every minute

Figure 14. Sensor Test Procedure
The calibration procedure allows the user to configure several parameters including the sensor sensitivity
and TIA gain used by the firmware when calculating the CO concentration (see Figure 15). All parameters
are saved to the MCU flash and are read and used during normal operation. The calibration procedure is
initiated after power-up by depressing the user button S1 while releasing the system from reset.
All communication between the firmware and user is carried out through the UART interface of the MCU.
A serial connection is required to communicate with the firmware during the calibration routine (see
Section 3.1.4).
From the calibration routine, the user can trigger a CO level measurement using the stored sensitivity and
TIA gain parameters. Because the UART lines are shared with the I2C lines going to the TMP103
temperature sensor, a temperature reading is not possible in this case. However, the user has the option
to specify a temperature. This test temperature is used to select a temperature correction factor during the
CO level calculation. The result of the calculation is printed through the serial console.
When the user exits the calibration routine the firmware will transition into a continuous sampling mode. In
this mode, the firmware will transmit a packet every second containing the CO level and temperature (see
Table 4). A hardware reset is required to exit the continuous sampling mode.
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START

Firmware configures UART and prints options
through serial console

User selects option: Set gain, change board ID,
set sensitivity, change test temp, perform CO
measurement

No

Exit calibration
routine?

Yes

Continuous sampling

Figure 15. Calibration Procedure
As indicated previously, the CC2650 broadcasts packets at different times to communicate with a host.
The format of the status packet is shown in Table 4 and described in Table 5. The firmware can also be
configured through a pre-compiler statement to transmit additional debug information as shown in Table 6
and described in Table 7.
Table 4. Status Packet Contents
BYTE 0 AND 1

BYTE 2

BYTE 3

BYTE 4 AND 5

BYTE 6

BYTE 7 AND 8

TIDA Num

Board ID

Status Flag

Battery Voltage

Temp

Gas Concentration

Table 5. Status Packet Byte Description
BYTE NAME
TIDA Num
Board ID

Status Flags

24

BYTE NUMBER

RESET VALUE

1:0

0x0738

2

0xFF

3

DESCRIPTION
Specifies the TIDA number. By default, these bytes are set to
0x0738, or 756 in decimal.
Specifies the board ID. This field can be set by the user through the
calibration routine.
Specifies the status of the system.
• Bit 0: TROUBLE
• Bit 1: ALARM
• Bit 2: OK
• Bit 3: CAL_ERROR
• Bits 4 to 7: Reserved
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Table 5. Status Packet Byte Description (continued)
BYTE NAME

BYTE NUMBER

RESET VALUE

DESCRIPTION
Battery voltage read from MCU internal battery monitor.

Battery Voltage

VBATT =

5:4

(Byte5 10 ´ 256 ) + Byte4 10
1000

(15)

For example, when Byte5 = 0x0C and Byte4 = 0x44, the battery
voltage is 3.140 V.
Temp

Temperature reading from TMP103 temperature sensor in Celsius.
For example, 0x1B = 27°C.

6

Gas concentration calculation in ppm.
Gas Concentration

(

)

GasCon = Byte8 10 ´ 256 + Byte7 10

8:7

(16)

For example, when Byte8 = 0x00 and Byte7 = 0xC6, the gas
concentration is 198 ppm.

Table 6. Additional Debug Information (If Enabled)
BYTE 8 AND 9

BYTE 10 AND 11

BYTE 12 AND 13

BYTE 14 AND 15

ADC Value

Sensitivity

Gain

Temp Correction

Table 7. Additional Debug Information Byte Description
BYTE NAME
ADC Value

BYTE NUMBER

RESET VALUE

9:8

DESCRIPTION
Raw value read from ADC during last CO calculation.
Sensitivity setting used for CO calculations. This value must be
set by the user through the calibration routine.

Sensitivity

11:10

0xFFFF

Sensitivity =

(Byte1110 ´ 256 ) + Byte10 10
1000

(17)

For example, when Byte11 = 0x04 and Byte10 = 0x19, the
sensitivity is 1.049 nA/ppm.
Gain setting used for CO calculations. This value must be set by
the user through the calibration routine.
Gain

13:12

0xFFFF

Gain =

(Byte13 10 ´ 256 ) + Byte12 10
1000

(18)

For example, when Byte13 = 0x06 and Byte12 = 0xF4, the gain
is 1.780 ×106 V/A.
Temperature correction used during last CO calculation. This is
read from an internal table, indexed by the last temperature
reading.
Temp Correction

15:14

TempCorr =

(Byte15 10 ´ 256 ) + Byte14 10
1000

(19)

For example, when Byte15 = 0x04 and Byte14 = 0x0E, the
temperature correction is 1.038.
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3

Hardware, Firmware, Testing Requirements, and Test Results

3.1

Required Hardware and Firmware

3.1.1

Hardware
Figure 16 shows the hardware for the Low-Power Carbon Monoxide (CO) Detector With BLE and 10-Year
Coin Cell Battery Life Reference Design. The printed circuit board (PCB) is in a 43×104-mm rectangular
form factor and comes with 0.5-in nylon standoffs to ensure ease of use while performing lab
measurements.
J1, Sensor connect
TP1, CO output

J8, JTAG programming
interface

TP6, Timer interrupt

J2, Main power jumper

TP3, Comparator threshold
TP2, Comparator output

S2, Reset
S1, User button

CR2032 Battery holder
(+ side up)

Figure 16. Low-Power Carbon Monoxide Sensor Reference Design Hardware Description
All the integrated circuits (CC2650, LPV811, and TLV3691), several test points, and jumpers are located
on the top side of the PCB. The antenna is also located on the top side of the PCB. The bottom side of
the PCB contains the CR2032 coin cell battery holder.
There are two CC2650 pins that have been brought out to header J6 for use during calibration. These pins
are configured as UART RX and TX pins during calibration for communication with a host through a serial
port.

26

Low-Power Carbon Monoxide Detector With BLE and 10-Year Coin Cell
Battery Life Reference Design

TIDUBX8C – July 2016 – Revised November 2017
Submit Documentation Feedback

Copyright © 2016–2017, Texas Instruments Incorporated

Hardware, Firmware, Testing Requirements, and Test Results

www.ti.com

3.1.1.1

Jumper Configuration

To facilitate measuring critical parameters and debugging in this reference design, there are several
jumpers included. To properly operate the design, these jumpers must be installed correctly.
The jumper configuration for normal operation is as follows:
• J1 = Shorted
• J2 = Shorted
• J6 = Open
• J8 = Open
The jumper configuration to load new firmware on the CC2650 is as follows:
• J1 = Shorted
• J2 = Open
• J6 = Open
• J8 connected to the 10-pin Arm Cortex Debug Connector on the SmartRF06 Evaluation Board (EVM)
through a ribbon cable
When connecting to a SmartRF06 EVM, set the source switch to "USB" and short the "VDD to EM" jumper
on the EVM. In this configuration, the SmartRF06 EVM provides power to the CC2650. For more
information, see the SmartRF06 Evaluation Board (EVM) User's Guide.
When running the calibration routine, the following jumper configuration is as follows:
• J1 = Shorted
• J2 = Shorted
• J6 = Connected to host
• J8 = Open
Jumper J6 brings out the CC2650 UART RX and TX pins. These pins can be used to communicate with a
host computer through the use of an external RS-232 transceiver such as the TTL-232R-3V3-PCB from
FTDI.
NOTE: Make sure to put the board in calibration mode before connecting an external RS-232
transceiver to connector J6.

3.1.1.2

Test Point Description

This design includes several test points to monitor critical signals. The following is a brief description of
these test points:
• TP1: Output of transimpedance stage and filter, which is also the input to the comparator
• TP2: Comparator output
• TP3: Threshold voltage input to comparator
• TP4, TP5: Ground points for probes or common points for voltage measurements
• TP6: System nano-power timer interrupt output
• TP7: Filtered battery supply input to the DC/DC converter in the CC2650
• TP8: Filtered DC/DC converter output from the CC2650
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Battery Requirements

Only insert an Energizer™ CR2032VP Lithium battery or a battery with equivalent specifications:
• CR2032 UL certified battery
• Voltage: 3.0 V
• Min capacity: 240 mAh
• Min discharge rate: 0.19 mA
NOTE:

3.1.1.4

The battery must be replaced by a trained professional.

Miscellaneous

A sensor can become polarized when it is stored a long time without a connection between the working
and counter electrodes. A polarized sensor can take a minutes or hours to stabilize after it is connected to
the operating circuit. This reference design uses a p-channel JFET to short the sensor electrodes when
the battery voltage is removed, which prevents the sensor from becoming polarized. However, when
installing a new sensor some time must be allowed for the sensor to stabilize. See the sensor datasheet
for details on sensor polarization and stabilization time.
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3.1.2

Firmware
The firmware used on this reference design was developed using TI’s CCS software (version 6.1.0). The
IAR Embedded Workbench for Arm also supports the CC26xx line of SimpleLink products.
The reference design hardware is programmed by connecting the 10-pin mini ribbon cable from J8 to the
SmartRF06 EVM (10-pin Arm Cortex Debug Connector, P410). On the SmartRF06 EVM, set the source
switch to "USB" and short the "VDD to EM" jumper. In this configuration, the SmartRF06 EVM provides
power to the CC2650. For more information, see the SmartRF06 Evaluation Board (EVM) User's Guide.
Before powering on the SmartRF06 EVM, configure the jumpers on the reference design hardware for
firmware loading (see Section 3.1.1). Specifically, make sure the J2 jumper is open on the reference
design hardware.
See Figure 17 for a photo of the correct setup for connecting the reference design hardware to the
SmartRF06 EVM.

Figure 17. Connection of SmartRF06 EVM and TI Designs Hardware for Programming and Debugging
After setting up all the hardware, follow these steps to load the new firmware on the reference design
using the SmartRF Flash Programmer 2:
1. Download and install SmartRF Flash Programmer 2 (http://www.ti.com/tool/flash-programmer).
2. Open SmartRF Flash Programmer 2.
3. In the "Connected devices" window, CC2650 should be listed under XDS100v3. If it is not listed, check
the power and connection from SmartRF06 to TIDA-00756 and click “Refresh” button to rescan for
devices. Highlight the CC2650 device.
4. In the "Main" tab, click the "Single" radio button.
5. IMPORTANT: In the "Main" tab, under "Actions", click the "Pages in image" radio button. This button
prevents the programmer from erasing any calibration values previously written to flash.
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6. Click on "Browse" button and navigate to the TIDA00756-Firmware.out file.

Figure 18. SmartRF Flash Programmer 2 Configuration
7. Click on the blue circle play button to flash the firmware image onto the reference design board.
The status bar on the bottom of SmartRF Flash Programmer 2 shows if flashing the image was
successful.
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3.1.3

Receiving Data Packets
As shown in Section 2.4.5, this reference design is programmed to monitor the CO level and periodically
evaluate the system status. The CC2650 broadcasts packets at different times to communicate with a
host.
Two methods to view the transmitted packets are described in the following subsections.

3.1.3.1

Receiving Data Packets Using CC2540EMK-USB and SmartRF Protocol Packet Sniffer

To verify the proper operation of the radio transmission, the CC2540EMK-USB CC2540 USB Evaluation
Module Kit is used to "sniff' packets using the SmartRF Protocol Packet Sniffer software. After installing
the Packet Sniffer software (v2.18.1 at the time of writing), the procedure is as follows to detect the data
transmissions:
1. Plug the CC2540EMK-USB into an unused USB port on the computer with the Packet Sniffer software
installed.
2. Open the Packet Sniffer software; choose "Bluetooth Low Energy" as the protocol and hit Start.

Figure 19. Packet Sniffer Software
3. Click on the Radio Configuration tab and verify that "Advertising Channel 39" is selected.
4. Press the Play button on the top toolbar to initiate the packet capture process.
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5. There will likely be many other packets detected. To view only the packets sent from the reference
design hardware, it is necessary to apply a display filter. Figure 20 shows a sample display of what will
be recorded with no filter applied. The highlighted row shows the desired data packet in the midst of
other, undesired data packets.

Figure 20. Packet Sniffer Software, Filterless Recording
6. The appropriate filter checks for non-connectable advertisement packets with ADV_NONCONN AdvA
field equal to 0x265026502650. In the Field Name, select ADV_NONCONN AdvA from the drop down
options. Click the "First" button. Modify the filter condition to the correct address, hit "Add", and then
click "Apply filter". An example filtered view is shown in Figure 21.

Figure 21. Packet Sniffer Software, Filtered Recording
7. To export the captured, filtered packets, press the "Saves the current session" button on the toolbar, or
pause the packet capture and click File → Save data…; either of these choices prompts to save the
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displayed data as a packet sniffer data (.psd) file.
8. Convert the .psd file to readable hex values with HexEdit software. A different hex editor can perform
this function as well; however, the authors of this guide have not verified any other options
9. Open the .psd file in the HexEdit software. Click on Tools → Options. In the HexEdit Options window,
click on Document → Display and change the Columns value to "271". Click Edit → Select All and Edit
→ Copy As Hex Text. Open a text editor program (for example, Notepad), paste the hex text, and save
the text file. This text file can then be imported into Microsoft® Excel® spreadsheet software for further
analysis. For more information on the sniffer data packet format, click Help → User Manual on the
packet sniffer software.
3.1.3.2

Receiving Data Packets Using SmartRF06 Evaluation Board and CC2650 Evaluation Module

The second method uses the SmartRF06 Evaluation Board and the CC2650 Evaluation Module hardware
to "sniff" the packets using SmartRF Studio. After installing the SmartRF Studio (v2.3.0 at the time of this
writing), the procedure to detect the data transmissions is as follows:
1. Connect the CC2650 EVM to the EM header on the SmartRF06 evaluation board.
2. Verify that the following jumpers are populated: P483, P484, P485, and VDD TO EM.
3. Power on the SmartRF06 board.
4. Run the SmartRF Studio software.
5. Click on the Refresh button and verify that CC2650 is listed under the Connected devices window.
6. Click on the "2.4GHz" tab and double click on the CC2650.
7. Select the "BLE mode" radio option.
8. Change the Bluetooth low energy channel to 39 and select the target configuration that matches the
CC2650 EVM.
9. Click the "Packet Rx" tab.
10. Check the "Infinite" box and leave all the other options as default.
11. Click the "Start" button.
The SmartRF Studio captures all Bluetooth low energy advertising packets on channel 39 and displays the
packet information. Figure 22 is an example snapshot.
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Figure 22. SmartRF Studio Packet Sniffer Recording

3.1.4

Loading Calibration Values
There are two methods for loading calibration values on the reference design. The first method uses a
calibration routine programmed into the reference design firmware. An external RS-232 transceiver is
required to complete this method. The second method uses the Flash Programmer 2 to load the
calibration values directly to the flash of the reference design.

3.1.4.1

Loading Calibration Values Using Calibration Routine

This reference design supports a calibration routine through which the user can perform such functions as
setting the CO sensor sensitivity and the TIA gain (see Section 2.4.5). To use the calibration routine,
follow these steps:
1. Configure the jumper settings on the board.
• J1 = Shorted
• J2 = Shorted
• J6 = Connected to host through external RS-232 transceiver, for example the TTL-232R-3V3-PCB
from FTDI
• J8 = Open
2. Connect the board to a host PC serial port.
3. Open a serial terminal (for example, Tera Term) on the host PC with the following settings:
• Baud rate: 115200
• Data size: 8 bits
• Stop bits: 1
• Parity: None
• Flow control: None
4. Power the board.
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5. Depress the user button S1 while releasing the reset button S2.
6. Follow the prompts on the serial terminal to complete the calibration routine.
NOTE: Make sure to put the board in calibration mode before connecting an external RS-232
transceiver to connector J6.

3.1.4.2

Loading Calibration Values Using Flash Programmer 2

Follow these steps to load new calibration values on the TI Design hardware using the SmartRF Flash
Programmer 2:
1. Download and install SmartRF Flash Programmer 2, http://www.ti.com/tool/flash-programmer.
2. Open SmartRF Flash Programmer 2.
3. In the "Connected devices" window, CC2650 should be listed under XDS100v3. If it is not listed, check
the power and connection from SmartRF06 to the reference design, and click "Refresh" button to
rescan for devices. Highlight the CC2650 device.
4. In the "Edit" tab, under "Select memory", click the "Address" radio button, and enter address "E000"
and length "5".
5. Click the "Read" button.
6. Update the five bytes with the new calibration values in hex format:
• Byte 0: Sensitivity MSB
• Byte 1: Sensitivity LSB
• Byte 2: Gain MSB
• Byte 3: Gain LSB
• Byte 4: Board ID
7. Click the "Write" button.
The status bar on the bottom of SmartRF Flash Programmer 2 will show if flashing the image was
successful (see Figure 23).

Figure 23. SmartRF Flash Programmer 2 Configuration for Loading Calibration Values
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Testing and Results

3.2.1

Test Setup
The Low-Power Carbon Monoxide (CO) Detector With BLE and 10-Year Coin Cell Battery Life Reference
Design has been characterized to support all of the critical specifications for this subsystem. The following
sections describe the test setups for these measurements including the equipment used and the test
conditions unless otherwise noted.

3.2.1.1

Power Consumption

The power consumption measurements for this reference design are critical in estimating battery life.
Measurements of supply current are performed on the reference design hardware.
The majority of the time, the system operates in a very low power consumption state, often only
consuming nano-amps of current. The test setup for measuring these small currents is illustrated in
Figure 24.
The resolution setting of the Agilent™ 34411A 6½ digit multimeter can place a limit on the amount of
instantaneous current flowing to the DUT. This limit can become a problem because at different points
during normal operation the current jumps from the nano-amp range to the milliamp range. For example,
when powering on the board, there is an initial inrush of current to the board. Generally, a resolution of 10
mA is enough to prevent any issues with current limits.
Agilent
34411A
A
BT1+
+

Agilent
E3632A

DUT

í

BT1í
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Figure 24. Test Circuit Used for Measuring Small Currents
The system will also experience peaks of high current such as those generated during radio transmission
and CO sensor tests. The measurement of these intervals involves using a current probe that interfaces to
an oscilloscope, which can then be used to trigger on the high current events. This setup is illustrated in
Figure 25.
Tektronix
TCPA300

Tektronix
TDS 3034B

A

Oscilloscope

BT1+
Agilent
E3632A

+

DUT

í

BT1í
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Figure 25. Test Circuit Used for Measuring Supply Current During High-Peak Currents
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3.2.1.2

Temperature and Humidity Range

This reference design is stressed under temperature and relative humidity bias to ensure the design
operates as expected under the extremes of the targeted environment.
The environmental chamber used for the temperature and humidity stress is the TestEquity™ 1000H
Temperature/Humidity Chamber with F4 Controller. A total of five reference design PCBs are placed in the
chamber: three with new Energizer CR2032 lithium-ion coin cell batteries and two powered with 3.0 V
from a benchtop DC power supply. A SmartRF06 EVM with CC2540EM board is placed outside the
chamber and connected to a laptop with a USB cable to monitor packets transmitted by the boards during
the test.
The reference design PCBs are loaded with firmware, which executes a system test every five minutes
and transmitted a packet indicating the system status. A returned status of OK indicated functionality of
the sensor, the analog signal path, and the radio. Carbon monoxide is not used during this test; however,
the system test ensured that the sensor is functional during and after the test.
Figure 26 and Figure 27 show pictures of the setup used for these temperature and humidity tests.

Figure 26. Temperature and Humidity Test Setup

TIDUBX8C – July 2016 – Revised November 2017
Submit Documentation Feedback

Figure 27. Reference Design PCBs Inside Environmental
Chamber

Low-Power Carbon Monoxide Detector With BLE and 10-Year Coin Cell
Battery Life Reference Design

Copyright © 2016–2017, Texas Instruments Incorporated

37

Hardware, Firmware, Testing Requirements, and Test Results

3.2.1.3

www.ti.com

CO Sensitivity

The sensitivity to carbon monoxide is measured on a reference design PCB using 100-, 200-, and 300ppm calibration gas. All tests are performed at an ambient temperature of 23°C in a lab with a relative
humidity of 50% ± 20%. The PCB is exposed to the temperature and humidity conditions for at least 15
minutes. The PCB is supplied with 3.0 V from a benchtop DC power supply.
The reference design PCB is loaded with firmware specifically modified to calculate the CO concentration
every second and transmit the result in a wireless packet. The firmware calculated the CO gas
concentration using Equation 14 in Section 2.4.5, with the sensitivity taken from the code printed on the
gas sensor and the gain set to 1.78 × 106 V/A. A temperature measurement is taken before each
calculation and a correction factor is applied using the information in the TGS5342 documentation. All
packets are captured using a SmartRF06 EVM as described in Section 3.1.3.2. The data is ported to
Microsoft Excel for final analysis.
3.2.1.4

Wireless RF Range

The range of the wireless 2.4-GHz RF is measured using the CC2540EMK-USB and SmartRF Protocol
Packet Sniffer described in Section 3.1.3.1. For this test, the CC2540EMK-USB remained at a stationary
location as the reference design is moved away from the CC2540EMK-USB. The reference design is
configured to continuously transmit packets every second. The two boards are always in direct view of
each other.
3.2.2

Test Data
NOTE: Unless otherwise noted, the test data in the following sections are measured with the system
at room temperature. All of the measurements in this section are measured with calibrated
lab equipment.

3.2.2.1

Power Consumption

Because the primary purpose of this reference design is to showcase a battery-powered wireless CO
sensor, characterization of the system’s power consumption is critical.
As described in Section 2.4.4, this reference design can be in one of multiple states during normal
operation: Standby, pre-alarm, alarm, and test. Both the duration and the average current of each state
are factors in estimating the total battery life of the reference design system.
This reference design remains primarily in the standby state, which is the default state when the CO level
is below the specified minimum concentration. It is critical that the power consumption of this state remain
as low as possible such that the battery life of the system can be maximized. In this state, the CO sensor,
TIA circuit, and comparator remain active to continuously monitor the CO concentration. The CC2650
receives power, but goes into its shutdown mode to minimize power consumption. The TMP103 is
completely powered off. The TPL5111 remains active to provide a timer interval to the CC2650 for
executing periodic system tests.
In the test state, this reference design initiates a system test to assess the functionality of the gas sensor
and the analog signal chain. The CC2650 comes out of its shutdown mode to carry out the required test
functions, but the device goes into its standby state as much as possible to conserve power. Note that the
CC2650 cannot use its shutdown mode because all volatile memory and register contents are lost, making
it impossible to keep track of the sequence of steps needed to carry out the system test (writing data to
MCU flash is discarded as an option to avoid using up flash erase cycles). Once the system test is
complete, this reference design transmits a packet with the results of the test and transition back into its
standby state if everything is normal.
When the CO concentration rises above the specified minimum concentration, the comparator triggers and
the design transitions from standby state to pre-alarm state. In this state, the CC2650 remains in its
standby mode and monitors the CO concentration every second. Like the test state, the CC2650 cannot
use its shutdown mode in the pre-alarm state. The TMP103 is powered only long enough to take a
temperature measurement such that the CO concentration can be corrected for temperature variations.
The CC2650 does not transmit any packets in this state.
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In the alarm state, this reference design performs all the functions of the pre-alarm state and additionally
transmits a packet to the host every minute and generate a visual indicator by toggling a system LED
every second. In this state, the design consumes the most amount of power.
3.2.2.1.1

Standby and Test State Power Characterization

The standby state current consumption is measured on five separate boards at multiple system voltages.
The results of all the measurements are shown in Figure 28. Each measurement is taken over a period of
60 seconds. All boards are allowed to settle for 60 seconds after system power-up before each
measurement. As expected, the current consumption increases with increasing system voltage.

Average System Current (A)
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Figure 28. Standby State Current Consumption Across System Voltage
As described in Section 3.2.2.1, the standby state is interrupted periodically by an interrupt from the
system nano-power timer. The reference design enters the test state during this time to carry out several
functions.
The current consumption in the test state changes between microamps and milliamps during this time,
making it difficult to measure the total current consumption of the state. However, several high-current
events are captured for analysis. Figure 29 captures the high-current event associated with the CC2650
coming out of its shutdown mode. In this case, the high-current consumption is attributed to the MCU
reading internal flash memory to load the firmware. Figure 30 captures the high-current consumption due
to the transmission of a packet containing the results of the system test.

Figure 29. Startup Current at Beginning of Test State
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The average system current is measured over several minutes such that the reference design transitioned
between the standby state and test state multiple times. This reference design transitioned to the test
state every five minutes. The statistics functions of the Agilent 34411A keeps track of the average current
over this time. The Agilent 34411A is set to an NPLC of 10 and a 10-mA resolution. The results of the
averaging are shown in Table 8.
Table 8. Standby State Plus Test State Average Current Over Several Minutes
VBATT (V)

AVERAGE TOTAL CURRENT (A)

AVERAGE TIME (MIN)

3.8

1.02E-06

36

3.0

1.11E-06

35

2.4

1.09E-06

35

The average current over the range of system voltages from 3.8 V to 2.4 V are used for battery life
calculations. This average current for this voltage range is 1.07 μA.
3.2.2.1.2

Pre-Alarm State Power Characterization

The current consumption in the pre-alarm state is measured on five separate boards at multiple system
voltages. The results of all the measurements are shown in Figure 31. Each measurement is taken over a
period of 90 seconds.
One observation from Figure 31 is that the system current decreases with increasing system voltage. This
decrease is expected because at lower system voltages, the internal DC/DC of the CC2650 must
recharge the bypass capacitors more often to maintain a constant supply voltage.
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Figure 31. Pre-Alarm State Current Consumption Across System Voltage
The average current over the range of system voltages from 3.3 V to 2.4 V are used for battery life
calculations. The current numbers from board 61 are used to calculate the average because these
represent the worst case from the batch of boards tested. This average current for this voltage range is
7.69 μA.
3.2.2.1.3

Alarm State Power Characterization

The current consumption in the alarm state is measured on a single board at multiple system voltages.
The results of all the measurements are shown in Figure 32. Each measurement is taken over a period of
180 seconds such that multiple packet transmissions are included in the measurement.
As expected, the average current at each system voltage is dominated by the LED current, which is in the
milliamp range. The current consumption of other system components and other CC2650 operations
average in the microamp range, total. Because the LED toggles on and off, the average alarm state
current depends on the LED toggling frequency and on-state duration.
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Figure 32. Alarm State Current Consumption Across System Voltage
The average current over the range of system voltages from 3.3 V to 2.4 V are used to calculate battery
life. This average current for this voltage range is 525 μA.
3.2.2.1.4

Battery Life Calculations

The main parameters that affect the estimated battery life of the entire system are:
• Capacity rating of the battery in milliamp-hours (mAh)
• State current consumption, average (μA)
• State duration per year (hr/yr)
The firmware supports four basic states: Standby, test, pre-alarm, and alarm. For simplicity, the standby
and test states are combined into a single state (see Section 3.2.2.1.1). Equation 20 describes the
estimated battery life of the system:
BatteryLifetime (yr ) =

Battery Capacity (mAh )
I Standby (mA )´ t Standby (hr / yr ) + I PreAlarm (mA )´ t PreAlarm (hr / yr ) + IAlarm (mA )´ t Alarm (hr / yr )

´ Derating Factor

(20)

The amount of time spent in each state per year depends entirely on the end-use case. However, for the
purpose of this reference design, the following use-case was defined:
• 52 3-second alarms, per year (weekly testing)
• 25 cycles of 5-second alarms, per year (random testing)
• 12 hours of alarm, per lifetime
• 7 days of trouble signal, per lifetime
• System test and beacon every 5 minutes
Using these requirements, the tPreAlarm and tAlarm times per year can be calculated as follows:
t Alarm =

t PreAlarm

(52 ´ 3 s + 25 ´ 5 s )çæ

1 hr ö
÷
è 3600 s ø

1 yr

æ 24 hr ö
12 hr + (7 d)ç
÷
è 1d ø
+
10 yr

12 hr
=
= 1.2 hr / yr
10 yr

(21)
(22)

Equation 21 assumes that the reference design are placed directly in the alarm state during weekly and
random testing although the design firmware does not include a mechanism to go directly into the alarm
state. Equation 21 also includes the 7 days of trouble signal since the power consumption would be very
similar to the alarm case. The 12 hours of alarm state and 7 days of trouble state are averaged over the
target lifetime of 10 years because these are lifetime requirements and not yearly requirements.
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Equation 22 assumes that the firmware cycles through the pre-alarm state before reaching the alarm
state. Finally, in reality the current consumption of 3-second and 5-second alarms are higher than IAlarm,
the average current consumption the reference design taken over several minutes during which an LED
toggles on and off and packet is transmitted every minute. However, because the duration of the weekly
and random tests is very short, the final lifetime calculation changes very little.
Substituting these time numbers and the current numbers derived in the preceding sections, the battery
life can be estimated as follows:
BatteryLifetime (yr ) =

3.2.2.1.5

240 mAh
´ 0.85 = 10.82 yr
1.07 mA ´ (8760 - 1.2 - 18.1)(hr / yr ) + (7.69 mA ´ 1.2 hr / yr ) + (525 mA ´ 18.1 hr / yr )

System Trade-Offs

Adjusting the interval of the system timer interrupt can lead to increased battery life. As described in
Section 3.2.2.1, the timer interrupt triggers the sensor function, which in itself generates a high-current
event due to firmware load from flash, and another due to the transmission of a wireless packet.
Increasing the interval of the timer adds more time between test cycles and, in effect, lowers the average
current consumption of the combined standby and test state (see Figure 33). The reduced current for
these two states inversely increasee the battery life (see Figure 34). Note that the current numbers for
Figure 33 are theoretical numbers based on test data and information provided in device data sheets.
However, measurements performed on hardware were performed as a sanity-check on a few of the data
points. All estimates are calculated assuming a VBATT of 3.0 V.
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Figure 33. Combined Standby and Test State Average Current versus Timer Interval
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Figure 34. Battery Life versus Timer Interval
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3.2.2.2

CO Sensitivity

The sensitivity to carbon monoxide is measured on a reference design PCB using 100-, 200-, and
300-ppm calibration gas. As shown in Figure 35, Figure 36, and Figure 37, the test PCB was able to
detect the injection of CO gas with no problems. Note that a 10-second moving average is added after the
test using Microsoft Excel for visualization purposes.
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Figure 35. 100-ppm CO Level Results
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Figure 36. 200-ppm CO Level Results
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Figure 37. 300-ppm CO Level Results
The data transmitted by the test PCB is analyzed to determine the accuracy of the gas measurement.
Microsoft Excel is used to calculate the minimum, maximum, and average readings at each CO
concentration level, after discarding data points during which the gas is being injected into the test setup.
The maximum percent error is also calculated for each set of data. Table 9 shows the results of these
calculations. The results agree with the TGS5342 documentation, which states a maximum error of ±15%
is to be expected when using the sensitivity data printed on the gas sensor.
Table 9. CO Concentration Measurement Results

3.2.2.3

TEST

MIN

MAX

AVERAGE

MAX ERROR

100 ppm

99

113

107.3

13.00%

200 ppm

201

214

207.2

7.00%

300 ppm

302

316

309.5

5.30%

Temperature and Humidity Range

This reference design is stressed under temperature and relative humidity bias to ensure the design
operates as expected under the extremes of the targeted environment. A total of five reference design
PCBs are exposed to two temperature and humidity conditions:
• 50°C with at a relative humidity of 40% for a total of three hours
• 0°C with a relative humidity of 30% for a total of three hours
In both cases, the environmental chamber is programmed to ramp the temperature from 25°C to the target
temperature and humidity at a rate of 1°C per minute, soak at the target temperature and humidity for
three hours, and then finally ramp back to 25°C at a rate of 1°C per minute.
All five boards ran a system check every five minutes to assess the functionality of the sensor, the analog
signal path, and the radio. The results of the system test, including a temperature measurement from the
onboard TMP103 sensor, are reported on a wireless packet. During and after the tests, none of the boards
reported a system failure. The temperature measurement data is plotted in Figure 38 and Figure 39 for
visualization purposes.
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Figure 38. Sensor Temperature Readings During High Temperature Test
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Figure 39. Sensor Temperature Readings During Low Temperature Test

3.2.2.4

Wireless RF Range

The wireless RF range was measured to be at least 54 meters in a typical office environment with a direct
line of sight. A longer range could not be tested due to physical constraints imposed by the office building
used for this test. Also, the transmit power on the CC2650 radio is set to 0 dBm.
This reference design is able to successfully transmit data packets down the entire length of a 54-meter
office building with minimal obstructions. However, radio performance likely varies in the end-equipment
environment because obstructions in the RF transmit path reduces range. For full verification of the
hardware transmitting characteristics of the reference design, further testing with end-equipment context is
required.
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4

Design Files

4.1

Schematics
To download the schematics, see the design files at TIDA-00756.

4.2

Bill of Materials
To download the bill of materials (BOM), see the design files at TIDA-00756.

4.3

PCB Layout Recommendations
To ensure high performance, the Low-Power Carbon Monoxide (CO) Detector With BLE and 10-Year Coin
Cell Battery Life Reference Design is laid out using a four-layer PCB. The second layer is a solid GND
pour, and the third layer is used for power rail routing with GND fills in unused areas. The top and bottom
layers are used for general signal routing and also have GND fills in unused areas. For all of the TI
products used in this reference design, adhere to the layout guidelines detailed in their respective data
sheets.
If this design is to be used in an environment where dust or moisture accumulation is possible, be aware
that it may be necessary to include a conformal coating to eliminate additional leakage paths due to the
operating environment over time.
The antenna on this reference design is the inverted F PCB antenna for 2.4-GHz transceivers and
transmitters. For more details about layout and performance, see the application report 2.4-GHz Inverted
F Antenna.

Solid ground plane on Layer 2
Power routed on Layer 3

Via stitching to ensure a low
impedance path is available for RF
noise

No copper pour around
the antenna section

Figure 40. Low-Power Carbon Monoxide Sensor Reference Design Layout Guidelines
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For the integrated DC-DC converter in the
CC2650, the input capacitors C33 and C34,
inductor L4, and output capacitor C37 were
placed such that a common ground area is
used for the capacitors. The ground area had
no ground vias and was directly connected the
ground pin on the CC2650.

Figure 41. DC/DC Routing Guidelines

4.3.1

Layout Prints
To download the layer plots, see the design files at TIDA-00756.

4.4

Altium Project
To download the Altium project files, see the design files at TIDA-00756.

4.5

Gerber Files
To download the Gerber files, see the design files at TIDA-00756.

4.6

Assembly Drawings
To download the assembly drawings, see the design files at TIDA-00756.

5

Software Files
To download the software files, see the design files at TIDA-00756.
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